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To get the best results and most predictability from color management,

you need to create your own device profiles. While this may seem like a

daunting process, it can be relatively easy to do, and the results are well

worth the effort. There is a wide range of profiling products on the market;

some of these are reasonably priced, easy to use, and able to profile most

types of devices.

Profiling products range from standalone products made specifically for

a certain type of device, to profiling “suites,” such as the GretagMacbeth

Eye-One bundle and the X-RiteColor Ensemble, which include a meas-

urement device and software that can profile scanners, cameras, displays,

printers, and even projectors.

The choice of profiling package depends on your own criteria: how

much it costs, how easy it is to use, what advanced features it includes,

and the quality of its results. Some professionals believe that packages

that take the Swiss Army knife all-in-one approach don’t do as good a job

at creating profiles as programs that are dedicated to creating a specific

type of profile. In any case, this lesson uses a variety of applications to

create device profiles. These are not the only or necessarily the best

products available; rather, they represent an assortment of solutions.

Lesson 4

Creating Custom Profiles

Ch04 APColor (070-135)  4/30/04  2:22 AM  Page 71



Understanding Measurement Devices
To calibrate displays and printers, a measurement device is required. There are

a variety of devices on the market, each with different capabilities. Buying a

measurement device is a complicated process in itself, and should you prefer to

skip the color babble, a decent spectrophotometer such as the GretagMacbeth

Eye-One will handle all of your color-management needs. Three basic types of

devices are used in graphic arts and publishing, as described below.

• Densitometer—A densitometer measures the density of ink on paper (that

is, the absorption of light), not color values. A densitometer can tell you

how much of a color is on the page, but not what the color is. This is use-

ful for a variety of purposes: to check whether the printing devices are

behaving, for example, or to calibrate a device. Densitometers can be

found on or near every printing press, but they are not useful for creating

device profiles.

• Colorimeter—A colorimeter measures the color value of a sample, using

color filters, within a specific color space. A colorimeter can determine if

two colors are the same; it does not, however, take into account the light

under which the samples are measured. Colorimeters are often used to

calibrate both LCD and CRT display types.

• Spectrophotometer—A spectrophotometer measures the wavelength of

light across the entire visible spectrum of colors. This type of measure-

ment is the broadest, and it can easily be translated into a number of values,

including those used by colorimeters and densitometers. As it can be used

to profile both displays and printers, the spectrophotometer is preferred

for device profiling.

These devices typically come in different flavors; some measure one patch 

of color at a time, while others measure strips in an automated fashion. The

automated devices cost more—sometimes much more—but save time and

reduce errors. Some devices, such as the GretagMacbeth Eye-One spectropho-

tometer, can measure single patches but also include an attachment that

enables the device to engage a strip-reading mode. Spend some time creating

profiles with a device that only measures patch by patch, and you will quickly

come to appreciate the value of an automated instrument. In case you were
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wondering, the Rolls-Royce of these devices is the GretagMacbeth iCColor

spectrophotometer—simply feed a target into the device, wait about 20 sec-

onds, and the measurements are complete, all for about $5,000.

NOTE � You can use the trial applications on this book’s CD to 

complete the exercises in this lesson even if you don’t have a color-

measurement device.

Creating Display Profiles
The display is where color professionals spend most of their time viewing

color information, and where they evaluate and adjust color data. And it just

so happens to be the easiest device to profile. Creating a custom profile for

your display will have a dramatic effect and will enable you to use your display

as a predictor of your output-device results.

Choosing High-Quality Displays
When investing in a display for high-quality color-managed workflows, one of

the primary considerations is whether to choose LCD or CRT technology.

Color professionals disagree as to which is better for color reproduction. Flat

panels, which are now the only type of display that Apple sells, tend to have

more contrast than CRTs, and the viewing angle may affect the appearance of

the color data.

Regardless of whether you choose CRT or flat-panel technology, keep in mind

that as with most things in life, you get what you pay for. So caveat emptor:

“bargain” displays simply don’t have the quality or response required for accu-

rate color reproduction.

Ultimately, it’s a matter of personal preference. Just be sure that for color manage-

ment, you use a high-quality display. “High” quality is subjective, but generally

it includes a small dot pitch (the distance between the dots onscreen), support

for high-resolution modes, and controls for color temperature and geometry.
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Displays degrade with age, becoming less bright and less reliable for viewing

color data over time. If your display is more than three years old, and you’re

dissatisfied with its handling of color data, consider a new display.

NOTE � If you use an LCD (flat panel) monitor, ensure that any meas-

urement device you use is designed for an LCD or includes an LCD

adapter. Devices with suction cups can damage LCDs.

Characterization vs. Calibration
When implementing color management, you often encounter the terms 

calibration and characterization, which can be confusing, but the difference is

really quite simple: calibration changes a device to a standard or to a known

state, while characterization is the process of measuring the characteristics of

the device and creating a profile. Most display color-management products do

both tasks, so the terms are often used interchangeably. If your profiling prod-

uct doesn’t do both simultaneously, or if you’re using different tools for each,

just remember to calibrate first, then characterize.

You can calibrate and characterize a display in three ways, which increase in

price and quality: using visual calibration, using a display calibrator, and using

a calibrated display system. After discussing how each method works, we will

create and compare profiles using visual profiling and an external display 

calibrator.

Visual Calibration

In visual calibration, your eyes are the measurement tool. Although visual cali-

bration does an excellent job of factoring in ambient lighting conditions in the

profiling process, this method is very subjective and is more prone to errors

and inconsistencies than device-based calibration. If your goal is to create con-

sistency among multiple displays—say, across all the displays in a production

shop—or consistency across time, then visual calibration may not be the best

solution, as you have no objective reference point.

Apple ships a very effective (and free) visual characterization tool with Mac 

OS X: the Display Calibrator Assistant. We will use it shortly to both calibrate

and characterize your display.
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Display Calibrators

Display calibrators use a measurement device along with software to profile

your display. This approach is automated and much less subjective than visual

calibration, in which you adjust the controls until the onscreen image appears

a certain way. The software flashes a range of colors on the screen, which are

measured by the device. The results are compared with the known values of the

various colors, and a profile is created that accounts for the particular results

of your display. In most cases, a profile created with a display calibrator will be

more accurate (and more expensive) than one created using visual calibration.

Calibrated Display Systems

The ultimate solution for a color-accurate display (which also happens to be

the most expensive) is a calibrated display system. Calibrated display systems

typically include a very high-quality monitor, a measurement device, software,

and a hood to shield the display from ambient light (a good idea regardless of

which type of system you use), all designed to work together. What makes these

systems so accurate is the integration of display, software, and calibrator. The

software communicates with the display and your graphics card and makes

adjustments in the display automatically. Calibrated display systems such as the

Sony Artisan and the Barco Reference Calibrator V are easy to use and provide

better results than visual calibration or third-party display calibrators. With a

calibrated display system, there is no guesswork involved, no loss of brightness

and gamut. If color is a critical component of your work, and you can afford

one of these systems, buy one.

The Sony Artisan is an example of a calibrated display system.
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The Sony Artisan software, for example, clearly indicates the calibration status

of the display, including the target color space, calibration results (including the

date of the last calibration), and display configuration details. If the display is out of

calibration, a warning alerts the user at startup as well in the Artisan application.

Preparing to Profile Your Display
We’re almost ready to create and compare some display profiles. But first, take

a moment to do a few things to increase the accuracy of the profile.

• Let your display warm up. For CRTs, that’s a minimum of 30 minutes,

preferably one hour. For LCDs, 5 to 10 minutes should suffice.

• Turn off screen savers and energy-saving settings. These can interrupt the

process.

• Determine your display’s settings: resolution, refresh rate, geometry, and bit

depth, and don’t change the settings (either through the display’s front-panel
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controls or through the operating system). If you change the settings, you

should re-profile the display.

• Set the Desktop to a neutral gray.

• Set the white point to 5000k (D50) or 6500k (D65), if supported by your

display. The overall goal is to match the tonal reproduction characteristics

of your display to the intended viewing conditions and output.

NOTE � LCDs and laptop displays typically lack controls for white point.

• Clean your display using a product specifically formulated for displays.

Most office supply stores carry this type of product.

• Avoid bright light directed at the display. Use a display hood, if available.

Using Visual Calibration to Create a Display Profile
Let’s create a profile for your display using Apple’s Display Calibrator Assistant,

a visual-profiling tool.

1 Open System Preferences by clicking its icon in the Dock, and then click

the Displays icon.

2 Click the Color tab.

Creating Display Profiles 77

Ch04 APColor (070-135)  4/30/04  2:22 AM  Page 77



3 Click the Calibrate button, and the Introduction screen appears.

The Introduction screen provides an overview of the Display Calibrator

Assistant and the steps required to use it.

4 Make sure the Expert Mode box is checked. Although the Expert Mode is

more involved, it gives you more options and produces better results.

5 Click Continue. The Native Gamma window appears.
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This is the first window for a five-step adjustment in the assistant, designed

to determine the luminance of your display. Luminance is the amount of

light emitted by the display.

The assistant uses two sliders to determine luminance. Each slider control has

a border that indicates the change made by moving the slider a certain direc-

tion. For example, on the brightness box (on the left), moving the slider

up increases the brightness; moving it down decreases the brightness. The

border of the control is lighter at the top, darker at the bottom. The con-

trol on the right, which affects color balance, shows the change in color

made by moving the slider toward the direction of a color on the border.

6 Adjust the left slider until the brightness of the Apple icon matches the

surrounding boxed background. Move the slider all the way up and all the

way down, and then narrow in on the spot that you think achieves the best

match. Next, move the right slider until the color of the Apple icon appears

most neutral. Again, move the slider around liberally and then home in on

the spot that appears to have the least amount of color in the Apple icon.

Keep in mind that this is a very subjective process, and there is 

no right or wrong answer—simply make the best choice you can. As the

instructions note, it does help to sit back and squint your eyes a bit.
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7 When you are satisfied with the adjustments, click Continue.

8 Repeat steps 6 and 7 four more times as prompted by the assistant, each

time further homing in on the luminance of your display as part of the

native gamma adjustments.

9 When the Apple icon essentially blends in with its background, click

Continue to move to the target gamma adjustment.
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Gamma is the ratio of contrast that is displayed. The higher the number,

the more contrast you will see.

10 Adjust the slider back and forth, watching the changes that occur in the

test image, until you see a good balance between highlights and shadows.

Use the clouds to examine the changes in the highlights, and the darker

parts of the mountains to examine the shadow detail.

At the ideal setting, the tonal gradations in the color bars should be

smooth, all the way from bright highlights to deep shadows.

The numbers underneath the slider represent the contrast ratio. Notice 

that there is a difference between Macintosh and Windows gamma settings.

If you are using the Display Calibrator Assistant with the intention of

matching displays between the two platforms, consider selecting the same

gamma on both systems. You will likely have a better match across the

Mac and Windows platforms if you use the PC Standard gamma of 2.2.

If you are unsure about this setting, set the slider at Mac Standard.

11 When you finish, click Continue. The Target White Point adjustment 

window appears.
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White point is the color temperature of the display, measured in kelvins.

The higher the white point, the bluer the white will appear; the lower the

white point, the redder the white will appear.

To understand this concept, notice the light at different times of the day.

During the morning and evening, when the sun is low on the horizon, the

light is warm and rich in color, or about 3500 kelvins. In the middle of the

day, when the sun is overhead, the light is cooler, about 6500 kelvins. These

temperatures are often noted as D50 (for 5000) or D65 (for 6500).

Most professional proofing systems and color-correct viewing booths used

by printers and photographers use D50 lights to simulate daylight. D50

was established as the prepress industry standard, although new standards

are emerging based on D65. The challenge with this, however, is that

printed materials and photographs will be viewed under many light con-

ditions. It’s important to choose a setting that your display can actually

reproduce. D50 may also make your display appear dim and yellow. As a

result, many users select D65, which results in a much closer match to

your output device.

12 Check the “Use native white point” box to use the white point that was

determined by the selections you made in the first steps of the process.

NOTE � Much like the target gamma setting, the white point differs

between Macintosh and Windows systems. Macintosh users will see the

best results by setting their displays to a D50 white point and a gamma of

1.8. PC users will see the best results by setting their displays to D65 and 

a gamma of 2.2. The exception to this rule is when both a Macintosh and a

PC are used in the same color-managed workflow. In this scenario, the

best results will be achieved by using a device calibrator or calibrated dis-

play system set to the same white point and gamma on both systems.
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13 Click Continue. The Administrator window appears.

Administrator options, enabled by the Expert Mode box checked in step 4,

let you share your profile with other users of the system.

14 Check the “Allow other users to use this calibration” box if you want others

to be able to share this profile.

15 Click Continue.

16 In the window that appears, name the profile, giving it a meaningful name

that will distinguish this profile from others for the same device. For exam-

ple, include the device name and its calibration settings.
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17 Click Continue.

Congratulations! You have just created a custom profile that factors in the

unique characteristics of your display, determined by the measurement

instrument—your eyes. The Conclusion screen that appears summarizes

the relevant details of the profile, which can be useful in comparing these

results to generic profiles for the device, an exercise that you’ll perform

later in this chapter.

Note the difference between Native Gamma and Target Gamma in this

window. The profile you just created compensates for the differences

between the native and desired gammas.

18 Click Done to close the Display Calibrator Assistant.

The Color tab of the Displays System Preferences window appears, with

the profile you just created selected from the Display Profile list. The dis-

play profile will be used by applications that support ColorSync to determine

which display profile to use.
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Using a Calibrator to Create a Display Profile
This exercise uses the GretagMacbeth Eye-One Match to demonstrate how to

calibrate and characterize, or profile, a display with a display calibrator. If you

don’t have a calibrator, or have a different product, you can still follow this

exercise to learn the general process.

1 Launch Eye-One Match by double-clicking its icon in the Applications

folder of your hard drive. The home screen appears.
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The home screen shows the types of devices that the software can profile:

displays (also called monitors), projectors, scanners, and printers. The 

Eye-One tool is very easy to use: help is available from every screen, and

the interface leaves little room for error.

2 Since we are creating a display profile, click the icon that looks like an

Apple Cinema Display.

3 Select the Advanced Profiling Mode, which allows you to chose the white

point and gamma of your display; we’ll do that later in this exercise.

4 Click the right arrow in the lower right of the screen to begin.

The first step in profiling is to calibrate the measurement device.

5 Place the Eye-One device on its base, which includes a reference target,

and click Calibrate to calibrate the device.
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Eye-One compares the results with the known value of the calibration

patch and makes any adjustments as needed.

NOTE � Not all calibrators include this step, particularly devices that 

calibrate only displays.

6 Click the right arrow to choose your display calibration settings.

This is where you can choose the white point and gamma of your display.
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NOTE � If your display has the capability to set the white point via the

hardware controls, set the display setting before calibrating.

7 Click and hold to view the Whitepoint pop-up menu.

The Whitepoint selection determines the color of the white of the display. The

device will measure the actual or native white point of the display, and then

the software will adjust the display to achieve the desired white point (or a

point as close to it as possible). The higher the number, the cooler (or bluer)

the white; the lower the number, the warmer (or redder) the white. The

Native Whitepoint setting instructs the software to use the measured white-

point value. This is often a good choice for displays that lack the controls

to select a white point, particularly LCDs. As noted previously, the typical

setting for the Mac is 5000 (also called D50). However, the D50 setting is

based on press output; desktop printer users will likely have better results

with D65.

8 Experiment with the various settings to see how they change your com-

puter display, and then choose Medium White (6500).

9 Click and hold on the Gamma pop-up menu.

The Gamma selection determines the relationship between light and dark

values, similar to contrast.
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10 Leave the Gamma setting at Macintosh Standard (1.8).

11 Click the right arrow and place the measurement device on the display.

As it calibrates and plots the gamut, the software will display and measure

a wide range of color values.

If you use an LCD such as the Apple Cinema Display or a PowerBook, make

sure that your calibration device is safe to use on an LCD. The suction cups

on devices designed for CRTs can damage the LCD. Most manufacturers

have an adapter, or a version that specifically works on LCDs.

Also, if you’re using an LCD, be sure to use the appropriate attachment,

which usually hangs the device with a counterweight. If you are using a

CRT, the attachment will typically have suction cups that will stick to the

glass. Once the device is attached, the software first automatically detects

where on the screen the sensor is located, and then begins the measure-

ment (some products may require you to manually start the process).

12 When the process is complete, the Save ICC Profile window appears. Save

the profile with a name that includes the calibration settings, and then

click the right arrow button. In this example, the profile was named with

the device name and date.
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The software indicates that the profile has been saved and that the profile

has now been set as the standard profile.

13 Click OK, and close the Eye-One Match application.

14 Open the Displays System Preferences panel, and click the Color tab.
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Your new profile is in the Display Profile list and is selected as the default

display profile.

NOTE � If your profiling product does not automatically set the display

profile, you will need to change it by selecting the correct profile from the list.

Comparing Display Profiles
Now that you have at least two display profiles—the default profile included

with your display and the profile created with the Apple Display Calibrator

Assistant—we can compare them. If your display didn’t come with a default

profile, then use one of the profiles included with ColorSync; this is simply an

exercise to illustrate the value of creating a custom profile.

1 Launch the ColorSync Utility inside the Applications > Utilities folder on

your hard drive.

2 Click the Profiles icon.
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On the left, the utility displays a list of all of the profiles installed on your

system, organized by category.

NOTE � If your list of installed ColorSync profiles appears different from

what’s shown in the preceding image, click the downward-pointing trian-

gle on the Profile list box and choose “Group by class.”

3 Click the triangle next to Display Profiles, and select a display profile, such

as Color LCD.

Information about this profile appears on the right. Notice the location,

color space, creation date, size, and other information about this profile,

including its Lab Plot 3D visual representation.
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4 Click and drag on the 3D color model to view this profile’s color space

from multiple angles, then release the mouse.

5 Click the triangle in the Lab Plot area and choose “Hold for comparison”

from the pop-up menu.

6 Choose the profile you created with the Apple Display Calibrator Assistant

(or one you created with your external display calibrator) from the left-hand

list. The ColorSync Utility displays an overlay plot of the two profiles.

The ghosted white outline in the figure is the first, generic profile.
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7 Click and drag the cursor over the color model to see how the profiles

compare throughout the range of colors displayed by the 3D color 

model.

Notice whether the color gamut of my custom profile is larger than 

that of the default profile—meaning that it includes more colors. If the

custom profile includes more data, it will be more accurate when used 

for soft-proofing. In some cases, the differences between two profiles 

may be very slight, and you will not be able to see any variation in the

color model.

You can compare any two profiles with the ColorSync Utility, which is 

a useful way to visualize the differences between the color gamuts of

two devices.

Ensuring Consistency Across Displays
If one of your goals is to have consistency across multiple displays in your

workflow, for example in a studio, the simplest way to reduce variability is to

use the same make and model of display and the same calibration system at

each workstation. If you choose to go with an external display calibrator, you

can save money by purchasing one physical device (or a few if you have a lot 

of systems) and running the software on each monitor. Just be sure to check

the manufacturer’s policy about software licensing—you may need a license

for each computer.

Whichever approach you select to calibrate displays, be sure to use only that

method to create a profile for each display. Consistency is one of the keys to

successful color management.

Keeping Profiles Accurate
A good rule of thumb is to recalibrate your display once a week: calibration is

easy, free, and effective. It’s also a good idea to recalibrate prior to any impor-

tant color work—say, a big job.
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Creating Digital Camera Profiles
Creating a profile for a digital camera is easy; creating a good profile is another

story. With input devices such as scanners, variability over time is low: the light

source is fixed, and each scan uses the same source. The challenge with creating

camera profiles is that there are a lot of variables—most of which change with

each photograph.

Lighting poses the biggest challenge. In the studio, lights have qualities, such as

color temperature and luminance, that change over time and with each photo

shoot. Simply moving a studio light will change the lighting conditions. In the

field, lighting changes by the minute as the sun moves across the sky. And like

other devices, each camera has its own subtle characteristics.

As a result, many experts contend that it’s only worth the effort to profile digital

cameras if you are a studio photographer with highly controlled lighting

setups. They believe it’s easier, faster, and cheaper to bring digital photographs

into a color-managed workflow using generic and working-space profiles.

Indeed, profiles cannot compensate for all variability and are not meant to

eliminate the need for image editing. Even for digital cameras, however, pro-

files can reduce the amount of time needed to color edit an image by as much

as 85 to 90 percent. If you choose to profile your camera, the trick is to deter-

mine which solution works best for you. Following are the three most common

options for profiling cameras.

1 Use a working space instead of a camera profile.

The simplest option is to convert your images to a working-space profile

when you edit it. If your display is calibrated and you are consistent with

your workflow, you will be able to use soft-proofing (camera workflow

and soft-proofing of images are covered in detail in Lessons 5 and 6) to

predict what the image will look like in print.

Certain cameras, particularly digital single-lens reflex models, enable you to

select the working-space profile for the camera. Once an image is taken, an

in-camera process converts the image from the camera’s native color space

(usually a generic profile for that model of camera) to the selected working
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space and embeds that profile in the image. This option is typically limited

to one or two working-space profiles, such as AdobeRGB or sRGB.

The Nikon D100 digital single-lens reflex camera has three Color Mode options:
AdobeRGB, which converts the image to the same working space used in
Photoshop, and two sRGB profiles.

In conjunction with the working-space profiles, it’s a good idea to create 

a custom white balance for each scene being photographed. Additionally,

working in RAW format enables greater flexibility during editing.

NOTE � If you chose to create a custom profile for your camera, disable

the use of a working space within the camera to avoid double color man-

agement (transforming the image twice), which will produce poor results.

2 Use the camera-profiling feature of your profiling software.

The process is simple: shoot an image of the target in each scene. Before

you process the images, create a profile from each shot of the target, and

use it as the source profile for the image. The results may vary; most pho-

tographers find that the results are flat and lack contrast, or that the profile

simply doesn’t do the job and doesn’t warrant the time required.

3 Use a profiling package designed specifically for digital cameras, such as

Integrated Color Corp.’s ColorEyes 20/20.

In the case of ColorEyes 20/20, you only have to create the profile once—

regardless of the lighting conditions—for each camera. The trick is to 

light the target precisely as instructed. While this requires a bit of time 

and patience, many photographers have found it to be worth the effort—

especially for studio photography. There are several key features in this

package: a specialized target; an extremely specific process for lighting 

and photographing the target; use of the camera’s gray balance in profile 
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creation; and finally, a profile-generating algorithm specifically designed

for digital cameras.

NOTE � Lessons 5 and 6 go into greater detail about the use of camera

profiles and working spaces in Adobe Photoshop.

Creating a Digital Camera Profile, Take One 
This exercise uses GretagMacbeth’s ProfileMaker 4.1 Professional to create a 

digital camera profile. If you have not already installed the trial version of

ProfileMaker Professional from this book’s CD, do so now before begin-

ning the exercise.

1 Launch ProfileMaker Professional and select the digital camera module 

by clicking the Camera icon.
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The first step is to select the reference file, which contains the expected

measurement data for the target in use. The profiling software will com-

pare the actual data from the photograph of the target to the reference

data in order to build the profile.

2 Choose ColorChecker DC.txt as your reference target file from the

Reference pop-up menu.

Next, you will select the target image—the actual target data from your

camera.
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3 Choose Open from the Sample pop-up menu.

4 In the Open dialog that appears, navigate to and select the file

ColorChecker-D100.tif in the Color Management in Mac OS X Book 

Files > Lessons > Lesson04 folder on your hard drive. If you have access 

to a ColorChecker DC or other target, use an actual image from your

camera rather than the included sample image.
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When you select the image, it opens automatically in another window that

allows you to adjust the crop.

5 Crop the target by adjusting the marquee so that the selection includes

only the color patch (exclude the grayscale patches that border the target).

It’s important to crop the image as described so that extraneous data, such

as that from the grayscale patches, does not affect the profile creation. Click

the Example button to see the exact crop. The Reset button will reset the

marquee to the default settings, while the Fit to Image Size button will

adjust the image of the target to fit into the crop window.

6 When you have adjusted all four corners, click OK to return to the

Camera tab of the main interface.

7 Now you’re ready to create the profile. Click Start.

ProfileMaker Pro displays a Save dialog and prompts you for a profile name.

NOTE � The demonstration version of ProfileMaker Professional

included on this book’s CD will not save the profile. The full version 

of the application is required to save profiles.
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8 Give the profile a meaningful name.

In this example, the profile name is “PMP D100 CCDC 1-5-04.” PMP indi-

cates that it was created using ProfileMaker Professional; D100 indicates that

the profile is for a Nikon D100 camera; CCDC stands for the ColorChecker

DC target; and 1-5-04 is the date it was created.

NOTE � ProfileMaker Professional automatically selects the ColorSync

Profiles directory to save the profile. If you use a different camera-profile

utility, be sure to store your profile in this directory.

9 Click Save. ProfileMaker Professional generates the profile. Depending on

the speed of your Mac, it will take approximately one minute. When fin-

ished, ProfileMaker Professional returns to the Camera window. Quit the

application when finished.
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Creating a Digital Camera Profile, Take Two
The following exercise uses the ColorEyes 20/20 Adobe Photoshop plug-in and

a sample target included on this book’s CD to create a digital camera profile.

If you have not already installed ColorEyes 20/20 from the CD, do so now.

1 Launch Adobe Photoshop and choose File > Open.

2 Navigate to the Sample Camera Capture Target.tif file in the Color

Management in Mac OS X Book Files > Lessons > Lesson04 folder on

your hard drive, and click Open.

NOTE � A photograph of the ColorEyes target is included on this book’s

CD for this exercise. If you have purchased ColorEyes, you can photo-

graph the target yourself as described in the user manual and open that

image of the target, instead of the sample file.
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3 If Photoshop displays the Missing Profile alert, select “Leave as is (don’t

color manage)” and then click OK. This tells Photoshop not to convert 

the file to a working space, as we don’t want to apply any color changes 

to the target.

4 To ensure that the file has opened correctly, look at the lower-left corner 

of the image window. The name of the working space should be displayed:

Untagged RGB. If it is, skip to step 9.
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5 If the profile name does not display, or if Photoshop displays an incorrect

profile, click the right-pointing arrow and select Document Profile from

the pop-up menu.

6 If Untagged RGB now appears, skip to step 9. If not, choose Image > 

Mode > Assign Profile.

7 In the Assign Profile dialog, select the Don’t Color Manage This Document

option and then click OK.

8 Once again, choose Document Profile from the image window’s pop-up

menu, and Untagged RGB should now display.

9 To launch the ColorEyes plug-in, select Filter > Integrated Color > ColorEyes.
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10 To provide ColorEyes with the appropriate reference file for the target

image, click the Choose Reference File button in ColorEyes’ main window.

The Choose a File dialog appears, enabling you to choose a reference file.

11 Navigate to the target reference file Sample Camera Target Reference

File.cie, located in Macintosh HD > Color Management in Mac OS X

Book Files > Lessons > Lesson04.

This file contains the known values for the target, which will be compared

to the values from the image of the target taken with a digital camera.

12 Click Choose. ColorEyes now displays a grid overlaid on the target image.

The grid tells the software where each of the patches are on the target, so

that the software can accurately process the data. It’s important to prop-

erly position the grid.
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13 Adjust the corners by dragging the square red handles of the grid until all

of the gray corner squares have a green dot.

14 Next, check the Maintain Camera Gray & Exposure box in the lower-right

area of the ColorEyes window.

This instructs ColorEyes to use the gray balance from the camera, result-

ing in a profile that will correct hue and saturation values but will leave

gray and exposure values untouched.

15 Give your profile an intuitive name in the Name Your Profile box, and

then click Create.
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ColorEyes processes the data and creates the profile, which is automatically

added to the ColorSync profile library, and returns you to Photoshop’s

main interface.

16 Close the image window or quit Photoshop without saving the file. The

target has been modified to illustrate the changes that were made in 

creating the profile.

These exercises demonstrate two approaches to creating camera profiles; using

camera profiles as part of a color-managed workflow will be covered in depth

in Lesson 5. Remember, digital cameras are perhaps the most difficult devices

to profile. The challenge is to photograph the target properly to create an accu-

rate profile. The benefits of camera profiles will be realized only when a high-

quality profile is both created and used in a color-managed workflow. If you

are just getting started with color management, you may consider first profiling

just your display and printer(s) to establish a color-managed workflow, and

then later, if you encounter inconsistencies and unpredictable outcomes with

digital images, profile your camera.
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Creating Scanner Profiles
Scanner profiles improve the consistency and predictability of your color images

and save you time. Creating scanner profiles is easy and straightforward: you

scan a target, and the profiling software compares the scan to reference data

for that target and generates a profile.

To create a profile for your scanner, you will need profiling software, a target,

and the target reference file. Ideally, you want the target to be the same film or

paper type as the original you’re scanning. For example, if you’re scanning a

print (also known as a reflective image), your target should be reflective; if your

image is on transparency or film (also known as a transmissive image), your

target should be transmissive.

NOTE � There are no targets for negative film. This is largely due to the

challenge of scanning negatives, caused by the orange mask in the negative.

The most common target is the IT8 target—IT8.7/1 for transmissive media,

IT8.7/2 for reflective media—although there are others. Whichever target you

use, you must have its accompanying reference file, which includes its unique

measurement data. The profiling software will compare the data from the scan

of the target to the reference file to make the profile.

Some profiling packages allow you to create your own reflective target by

printing an image file of the target. The process is straightforward: first you

print the target, then measure it to determine the color values, then you scan

the target. The software uses your measured values as the reference file.

Preparing to Profile Your Scanner
Here are a few guidelines to keep in mind when scanning the target:

• Clean the target before scanning.

• Crop the target using the crop marks (see the example in the following

exercise).
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• Select a moderate resolution: 150 dpi will suffice; any more resolution is

not necessary and will result in longer processing times. Use 16 bits if

supported. A bit depth of 16 bits captures more color data for the profil-

ing software to work with.

• Straighten the scan in Photoshop if necessary. If the scan is not straight,

the profiling software will have difficulty finding the patches, resulting in

profile errors.

• Don’t adjust the resulting scan except to straighten it.

• Don’t embed a profile in the resulting scan.

Here are some guidelines for creating good scanner profiles:

• Keep settings consistent: whatever settings you select to create the profile,

use them to scan images. If your scanner software can save settings as 

presets, use this feature to ensure consistency.

• Turn off your scanner’s automatic adjustment features. If you can’t turn

the automatic modes off, you’ll have a hard time profiling the scanner.

NOTE � You can leave Applied Science Fiction’s Digital ICE and GEM

features alone—they don’t affect color management.

• Turn off sharpening in the scanner, and sharpen in Photoshop.

• The easiest solution is to use the default scanner settings, which are often

wide open, and edit in Photoshop.

• With some scanners you can use a display profile for onscreen previews.

This improves the accuracy of the onscreen preview because it factors in

the unique characteristics of your display—another reason to create a 

custom display profile!

If you send your images out to be scanned, ask the service bureau

to embed the scanner profile in the saved image. If the service bureau staff

will be editing the image for you, insist that they embed the Photoshop

working-space profile in the saved file.
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Using a Target to Create a Custom Scanner Profile
For the purpose of this exercise, we’ll use GretagMacbeth ProfileMaker

Professional and the accompanying sample scanner target. Other profile-

creation suites include comparable functionality.

1 Launch ProfileMaker Professional. By default, it opens to the Monitor 

profiling tab.
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2 Click the Scanner button to begin. The Scanner profiling window opens.

3 Choose C31102xx.txt from the Reference pop-up menu.

This tells ProfileMaker Professional which reference file to use in the profile

creation. The reference file contains the known values for the corresponding

target. ProfileMaker Professional provides support for different scanner

target files, any of which can be used as long as you have the accompany-

ing reference file. This exercise uses a sample reference file installed with

ProfileMaker Professional.
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4 Choose ExampleScan.tiff from the Sample pop-up menu.

The Sample selection is used to select the scan of the target. This exercise

uses a sample scan installed with ProfileMaker Professional.

Once the scan is selected, a window automatically opens showing the scan

of the target.
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5 Crop the target by adjusting the marquee so that the selection includes

only the color patches within the crop marks as well as the grayscale ramp

at the bottom, as shown in the following image.

It’s important to crop the image as described so that extraneous data does

not affect the profile creation. Click the Example button to see the exact

crop location. The Reset button will reset the marquee to the default set-

tings, while the Fit to Image Size button will adjust the image of the target

to fit into the crop window.

6 Click OK to return to the Scanner tab of the main interface when you 

have adjusted all four corners. The Reference and Sample files should be

selected, as shown in the following image.
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Two additional advanced options are provided: Profile Size and Perceptual

Rendering. Profile Size enables you to change the size of the profile created.

Large provides the best results in exchange for longer processing times.

Select Large; with today’s fast computers, there is a trivial difference in

processing times between Large and other settings.

Perceptual Rendering factors the media and color characteristics of the

device in such a way as to ensure that the human eye will perceive the

image in the most faithful reproduction possible of the original. The rec-

ommended setting is Preserve Gray Axis.

ProfileMaker Professional is now ready to create the profile.

7 Click Start to create the profile.
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8 Save the profile using a meaningful name such as the scanner name, the

date the profile was created, and the media type. ProfileMaker Professional

automatically selects the Profiles directory to save the profile in.

NOTE � The trial version of ProfileMaker Professional included on this

book’s CD does not save profiles.

9 Quit ProfileMaker Professional.

Creating Profiles for Output Devices
Creating a profile for your printer is the ultimate step in creating a color-

managed workflow. While it may seem like a daunting task, it’s easier than it

seems, and it can have a profound impact on the effectiveness of your color

management system. Once you have an accurate printer profile, tasks like 

soft-proofing (simulating your printer on your display) and press-proofing

(simulating a press on your printer) become not only possible but also invaluable.
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Many printer manufacturers now include high-quality profiles for their

devices in the box; some even include profiles for different paper and ink 

combinations. While these profiles are often quite accurate and will definitely

make an improvement, they do not factor in variables such as subtle differ-

ences in ink and paper lots, changes that occur as a printer ages, and other

environmental factors. They also don’t help if you use third-party inks or

papers, as even minor variations in paper noticeably affect how color is repro-

duced. For more accurate color management, creating a custom profile is the

way to go.

To create printer profiles, a color-measurement device is used to measure

patches printed from your printer. The device is controlled by the profiling

software, which generates the profile by comparing the expected values with

the actual values.

All profile-creation suites offer the capability to profile printers (many also

include a suitable measurement device such as a spectrophotometer or col-

orimeter) in an easy-to-use package. The more expensive packages typically

provide more advanced features (and increased complexity), such as greater

control over the algorithm used to generate the profile, the capability to profile

presses that use more than four colors, and profile editing (adjusting the pro-

file after it has been created). If you need these types of advanced features,

then evaluate packages such as GretagMacbeth ProfileMaker Professional or 

X-Rite’s MonacoProfiler.

Preparing to Profile Your Printer
The fundamental process for creating a printer profile is relatively simple:

You just print a target—or a set of color patches, which are typically included

with the software—and measure it with a device. The software then generates

a profile.
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There are some important details to be aware of before starting:

• Determine whether your output device is CMYK or RGB. The profiling

software will require you to print a target for one color space or the other.

Most desktop printers are RGB, while most printing presses are CMYK.

Desktop printers such as the Epson Stylus Photo and Canon photo printers

are RGB, even though they use CMYK inks (the printer driver converts

everything into RGB). If you’re unsure whether your output device operates

in CMYK or RGB, contact the manufacturer’s technical support or use the

exercise in Lesson 3 to find out before you create the profile.

• Calibrate your measurement device. As discussed in the beginning of

this lesson, you will need an appropriate measurement device, such as 

the GretagMacbeth Eye-One Pro or X-Rite DTP41 spectrophotometer.

Calibrating the device before profiling ensures that the device is measur-

ing properly.

• Select the appropriate target. Most profiling applications include targets

for different printers—at least for RGB and CMYK devices—and are

designed to work well with a particular device. However, a number of

targets are based on industry standards or are from known color gurus;

these targets are often available for download on the Internet. They range

in number and diversity of patches, layouts for specific devices, and page

sizes. The target included with your software should suffice. If your profil-

ing software supports different targets, try one with more patches to see 

if more data points improve the quality.

• Print the target properly. It is extremely important to follow the instruc-

tions for printing the target (provided with the profile-creation software),

as there are specific steps required for printing the target, such as turning

off the color management (compared with turning it on for normal print-

ing) and setting the resolution and size.
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Creating a Printer Profile
For the purpose of this exercise, we’ll use GretagMacbeth ProfileMaker

Professional. Other profile-creation suites include comparable functionality.

1 Launch ProfileMaker Professional. By default, it opens to the Monitor 

profiling tab.

118 Creating Custom Profiles

Ch04 APColor (070-135)  4/30/04  2:24 AM  Page 118



2 Click the Printer button to begin. The Printer profiling window appears.

3 Chose the target reference file i1 RGB 1.5 Ref.txt from the Reference

menu. This tells ProfileMaker Professional which target you will use to

profile your printer.
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ProfileMaker Professional includes a large number of targets and corre-

sponding reference files, which provide support for different instruments,

printer types, and target types. There are two important factors in select-

ing the target. First, determine whether your printer is RGB or CMYK;

each supported target is labeled either RGB or CMYK.

NOTE � Complete the exercise in Lesson 3 to determine your printer type.

Second, determine which measurement instrument you will use.

ProfileMaker Professional includes targets preformatted for different

instruments. For example, i1 RGB 1.5 Ref.txt is preformatted for the 

Eye-One device and for an RGB device, so it is the target we selected for

this exercise.

Now that you’ve selected the target reference file according to the device

and printer type, you will open and print the actual target.

4 Launch Photoshop by double-clicking its application name or icon in the

Applications folder of your hard drive, or by clicking it in the Dock.

5 Choose File > Open and navigate to the Applications > ProfileMaker Pro

4.1.5 > Testcharts > EyeOne folder on your hard drive.

6 Choose the i1 RGB 1.5.tiff target and click Open.
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7 If Photoshop presents the Missing Profile dialog, choose “Leave as is (don’t

color manage).” This tells Photoshop not to convert the file to a working

space. Then click OK.

8 Ensure the file has opened correctly by checking the information area 

in the lower left of the image window. It should read Untagged RGB if

you’ve opened the RGB target, or Untagged CMYK if you’ve opened the

CMYK target. If so, skip to step 13.
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9 If the information area reads differently, choose Document Profile from

the pop-up menu.

10 If the pop-up menu says Document Profile but the information area still

doesn’t say Untagged RGB/CMYK, choose Image > Mode > Assign Profile.

11 In the Assign Profile dialog box, choose Don’t Color Manage This

Document and click OK.

12 Check the information area again, choosing Document Profile from 

the pop-up menu if necessary, and it should read Untagged RGB or

Untagged CMYK.

Now we can print the target.

13 Choose File > Print with Preview.
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14 In the Print dialog, check the Show More Options box and choose Color

Management from the pop-up menu just below it.

15 Under Source Space, choose Document: Untagged RGB, and under Print

Space, choose Same As Source from the Profile pop-up menu. As in previ-

ous exercises, we’re telling Photoshop not to color manage the file but

rather to send it straight to the printer. The goal is to capture the printer’s

native gamut. Applying any color management will affect the results.

16 Click Print, and in the printer driver dialog that appears, choose your

printer from the Printer pop-up menu.
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17 Click the Copies & Pages pop-up menu to locate your printer’s media set-

tings, and then choose the correct paper for your device. The location of the

media option varies with each printer; look for it under a heading such as

Print Settings, as shown in the following figure. This is an essential step,

as the media option controls the amount of ink the printer will use. If the

paper you’re using is not listed, either check with the paper manufacturer

or choose the closest available setting. If you have the option, disable any

automatic settings (such as by selecting Advanced Settings, also shown in

the following figure).

124 Creating Custom Profiles

Ch04 APColor (070-135)  4/30/04  2:24 AM  Page 124



18 Click the Copies & Pages pop-up menu again to locate your printer’s

color-management options, and turn them off. The location of these

options varies with each printer; look for them under a heading such as

Custom, Advanced, or Color Management. The following image shows the

Color Management option in the Epson Stylus Photo 2200 printer driver,

with No Color Adjustment selected.

Save these printer settings to use again when printing with the

profile. It’s important to always print with the same settings—changing

the resolution or paper type will affect the results. Save them by choosing

Save As from the Presets menu.

19 Click Print to start printing the target.
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20 Once you have successfully printed the target, return to ProfileMaker

Professional to begin measuring the printed target.

21 Select Open from the Sample menu. Navigate to the Color Management in

Mac OS X Book Files > Lessons > Lesson04 folder on your hard drive and

select the Stylus_Photo_2200_i1.txt file.

126 Creating Custom Profiles

Ch04 APColor (070-135)  4/30/04  2:24 AM  Page 126



This file contains measurement data for the Epson Stylus Photo 2200 with

the i1 target. At this stage, you would normally use your instrument to

measure the printed target. Instead of selecting a file containing the meas-

urement data, you would select a device from the Sample list. Selecting a

device from the list enables ProfileMaker Professional to communicate

with the instrument directly.

Wait until the target is dry before measuring it.
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Several options affect how the profile is created. Profile Size and

Perceptual Rendering were discussed in the previous exercise. Gamut

Mapping describes how out-of-gamut colors are adjusted so that they are

in gamut. ProfileMaker Professional provides two methods: LOGO Classic

(which I selected) or LOGO Chroma Plus. Either one is a good choice.

The Viewing Light Source option should be set to the color temperature 

of the lights under which you will view images. For example, if you have a

light box, select the color temperature that corresponds to your light box.

If you will use ambient lighting to view images, select D65. The best method

to determine the correct setting for Viewing Light Source, aside from using

a light booth, is to experiment with different settings and compare the

results with the display.

22 Click Start to create the profile. ProfileMaker Professional will prompt 

you to name the profile. Again, use a meaningful name: for example, the

printer name, paper type, and date it was created.

NOTE � The trial version of ProfileMaker Professional included on this

book’s CD does not save profiles.
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23 Click Save. ProfileMaker Professional will process the data and create the

profile. It will take several minutes to create the profile, during which time

ProfileMaker Professional displays a progress bar.

24 When ProfileMaker Professional is finished, choose File > Quit.

Comparing Output Profiles
Once you’ve created a custom printer profile, you can easily compare it with

the generic profile for your printer, similar to the way you compared your dis-

play profiles earlier in this lesson. This exercise will show you how to do that,

which will illustrate the value of creating a custom profile for your printer.

1 Launch the ColorSync Utility inside the Applications > Utilities folder on

your hard drive.

2 Click the Profiles icon.
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On the left, the utility displays a list of all of the profiles installed on your

system, organized by category. If your screen looks different, click the 

triangle on the Profile list box and select “Group by class” to change the view.

3 Choose a generic profile for your printer from the list, such as SP200

Premium Luster_PK. Information on the selected profile, including a 

3D color model, is displayed on the right.

Notice the location, color space, creation date, size, and other information

for this profile, including its Lab Plot 3D visual representation.
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4 Click the triangle in the Lab Plot area and choose “Hold for comparison”

from the pop-up menu.

5 Choose a profile for your printer such as JW E2200 PremLstr 1_27_04

from the left-hand list. The ColorSync Utility displays an overlay plot of

the two profiles.
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The ghosted white outline is the first profile, the generic Stylus 2200 pro-

file, compared to the profile created for me by Chromix. The areas on the

outside of the cube, in color, and the dark section crosscutting the cube

are areas where the custom profile contains more data than the generic

Epson profile. The custom profile’s larger color gamut can be attributed to 

a number of factors: differences in the ink or paper, a newer printer driver

that is affecting the output of the printer, or variables in the profiling

device and software.

The custom profile’s larger color gamut, however, doesn’t ensure that it

will yield better, more accurate, or more predictable color output. The

only sure way to determine which profile provides the best results is to

visually compare the results of each profile both onscreen and in print.

Once your system is fully profiled and your applications are set up, print

an image using each profile, and then compare the results, both between

the profiles and with what you see onscreen (an exercise you’ll complete 

in Lesson 6).

You can also use the preceding exercise to compare other, disparate profiles:

your display profile to your printer profile, for example. That will illustrate the

differences in the devices, and you will get a much better picture of the differ-

ences by running the comparison yourself; the figure in step 5 on the preceding

page shows only one angle of the three-dimensional color gamut. As you rotate

the color model, you will see areas of color that do not overlap.

Try this exercise with profiles for your devices, as well as standard press profiles

such as U.S. Sheetfed Coated v2.
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Profiling Printing Presses
With desktop printers, you can control the device and you are typically 

making a few prints at a time. With a printing press, in contrast, you typically

have no control and are making a lot of prints. Due to the expensive nature 

of printing on press, color becomes even more critical. You can still take

advantage of color management if the final destination for your color work 

is a printing press, but since you will have less control over the process, you

will need to work with your printing partner to determine how to best handle

color management.

Most printing companies utilize process control to keep their presses printing

consistently, often to one of several printing industry standards (based on the

specific process, paper type, etc.). The ideal situation is to find a printer that

understands color management and has custom ICC profiles to which they

keep their press(es) calibrated. Many printers will have instructions for using

these profiles in conjunction with their services. Lesson 9 will cover the use of

profiles to proof and separate your color documents in more detail.

An important issue to keep in mind with traditional offset printing is that—

from the moment you hand your color data to the printer to the time the job

comes off the press—getting your document printed introduces several steps,

each of which has its own variables that can affect the final color. Your docu-

ment may be output to color-separation films, which are then used to make the

plates for the press. The printer will likely insist that a proof be made (often

called a contract proof). Since the printer will agree to match this proof (hence

the term contract proof), it’s important to carefully check the film proofs and

make changes based on how they look. The press plates will be made from the

same color data as the proof.
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Digital presses reduce the variability (and cost) of offset printing by eliminating

the need for films and plates. Most digital press operators will still offer a proof,

although it will typically be from a desktop printer (such as a high-quality inkjet

printer) using profiles that simulate the press. You can also use your desktop

printer to simulate the press (a technique covered in Lesson 9). Regardless of

the type of press, it’s a good idea to give your proof to the printer.

Finally, you’ll want to insist on a press check to ensure the prints coming off

the press match the contract proof.

If your printer doesn’t offer ICC press profiles, you have a few choices:

1 Use standard press profiles (such as SWOP) to proof and separate your

images. Then communicate with your printer—let the printer know what

type of press profile or standard you used to separate your images. Be sure

to use a contract proof. Press profiles are widely available, and applications

such as Photoshop typically include several standard press profiles.

2 Find a new printer who offers ICC profiles and keeps its presses well 

calibrated.

3 Create the press profile yourself, although this is not highly recommended

unless you operate your own press. It will be expensive, but if you’re doing

enough printing with that printer, it can be worth it. The process is essen-

tially the same as the exercises included in this lesson, except the choice of

target will be different. You’ll want a CMYK target, such as the one included

with ProfileMaker Professional.

The most important point in creating or obtaining press profiles is to commu-

nicate with your printer about the process.
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